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Agenda

• Do we need Office 2007?

• The New Office Interface

• New Formatting Tools

• File Compatibility• File Compatibility

• Notable Changes and New Features

• Available Resources

• Rollout Plan
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Do we need Office 2007?

Need?

•Is there an administrative
need?

–No
•Is there an academic
need?

Obstacles

•What are the main 
obstacles?

–New Interface
–Compatibility Issues
–Minor Individual need?

–Yes
•Is there a 
technical/support need?

–Yes

–Minor Individual 
Program Changes and 
Enhancements
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Bottom line: Everyone will need to be trained!



Office 2007 Applications

Included Applications:
• Microsoft Office Word 2007
• Microsoft Office Excel 2007
• Microsoft Office PowerPoint 2007
• Microsoft Office Outlook 2007
• Microsoft Office Access 2007• Microsoft Office Access 2007

Additional New Applications:
• Microsoft Office Groove 2007
• Microsoft Office InfoPath 2007
• Microsoft Office OneNote 2007
• Microsoft Office Publisher 2007
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Office 2003 Review

POP QUIZ!POP QUIZ!
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POP QUIZ!POP QUIZ!



Office 2007 Main Concepts

• User Interface
– Office Button, Ribbon, 

Quick Access Toolbar, 
Status Bar

– On-Demand Tools
• Contextual Tabs

• Saving and 
File Compatibility
– Notable Changes and 

New Features
– Resources

• Contextual Tabs
• The Mini Toolbar

– New Features
• Galleries
• Live Preview

– Help
– Program Options Office 2007 6



The New User The New User 
InterfaceInterface

Office 2007

InterfaceInterface
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The Microsoft Office Button

• The Office Button 
replaces the “File” 
menu, but the button 
offers more commands 
than the “File” menu did. 

• In previous versions of 
Office, you could set The Microsoft Office, you could set 
options in the “Options” 
dialog box, which you 
opened through the 
“Tools” menu. Many of 
those options can now 
be found when you click 
the Microsoft Office 
Button.
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The Microsoft 
Office Button
appears in the 
upper-left corner
of the window in 
several Microsoft 
Office programs.



The Ribbon

• Menus and toolbars have been replaced by the Ribbon , 
which contains tabs that you click to get to commands.

• With the Ribbon, commands and other tools you need 
are now exposed and more readily available.

• Use the Ribbon to do what you’re used to doing.
• You can hide and unhide the Ribbon to make more/less 

workspace by double-clicking on a tab.workspace by double-clicking on a tab.

Easy-to-browse
Commands

Ribbon

Tabs organized in 
the order of use
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The Ribbon is Organized into 3 parts

Tabs

GroupsGroups

Commands
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The Core Tabs

• Tabs sit across the top of the Ribbon. Each one 
represents core tasks you do in a given program. 

• See additional handouts for information about each tab.
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The Core Tabs

PowerPoint
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Outlook



How Groups and Commands 

are Organized
Commands are 
organized by how 
they’re used.

•Groups are sets of related 
commands. They remain on 
display and readily available, 
giving you rich visual aids. 
•Commands are arranged in 
groups. A command can be a 
button, a menu, or a box where 
you enter information. 

•Frequently used core commands no 
longer have to share space with a 
range of remotely related commands 
on a menu or toolbar. 
•They’re the ones that get used, and 
so now they’re the ones most 
prominently featured. (or larger in 
size)

Groups

Commands
13
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ScreenTips

• If you mouse over a command, Office 2007 will give you 
a brief description of the command and where to go for 
more help.

ScreenTip
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Dialog Box Launchers

• Sometimes an 
arrow, called the 
Dialog Box 
Launcher , appears 
in the lower-right in the lower-right 
corner of a group.

• This means more 
options are available 
for the group.
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Additional Tabs – “Add-Ins”

• The “Add-Ins” tab is automatically created if 
you have third-party plug-ins for Microsoft Office.
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Additional Tabs - “Get Started”

• The “Get Started” tab gives you access to free
online Microsoft Training for Microsoft Word.

• For Word 2007, Excel 2007, and PowerPoint 
2007, there’s a visual, interactive reference 
guide to help you quickly learn where things are 
if you can’t find a command in Office 2007.if you can’t find a command in Office 2007.
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Additional Tabs – “Community Clips” 

• The “Community Clips” tab allows you to 
record your computer screen so you can make 
movie files on how to carry out a procedure in 
Word, Excel, or PowerPoint 2007.

• You can e-mail or Xythos these files to your 
colleagues.colleagues.
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Other Additional Tabs

• Additional tabs are automatically created if you 
have third-party software that interacts with 
Microsoft Office.  They used to be “menus” in 
Office 2003.

• Adobe Acrobat Professional is an example.• Adobe Acrobat Professional is an example.
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Contextual (On-Demand)Tabs

• Contextual or 
On-Demand tabs 
appear only when 
you need them.

• They provide 
more commands 

Contextual
TabCore Tabs

more commands 
to manipulate the 
object you have 
selected.

• The tab 
disappears when 
you deselect the 
object.

Selected
Object
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The Quick Access Toolbar

• Located above the Ribbon when you first start your 
Microsoft Office program, the Quick Access Toolbar
puts commands where they’re always visible and near at 
hand. 

• You can easily add and remove commands from the 
Quick Access Toolbar.

• You can move the Quick Access Toolbar above or below • You can move the Quick Access Toolbar above or below 
the Ribbon.
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Quick Access Toolbar

Save

Undo

Repeat



The Status Bar

• The bottom part of the Office windows gives you 
clickable access to certain Office commands.
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Theme Used Type of View
Fit slide to

current window

Zoom Details
Slide Details



New New 
Formatting Formatting 

Office 2007

Formatting Formatting 
ToolsTools
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New Formatting Tools - Mini Toolbar

• The Mini Toolbar is a new addition to Office 2007 that 
appears when you select text.

• It provides you with common text formatting options 
found on the “Home” tab.

• It allows you to save time so you don’t have to go to the 
“Home” tab to find the common formatting commands 
you need.you need.

Mini Toolbar

Selected Text
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Formatting Options on the 

Mini Toolbar

• Word and Outlook 
share the same 
mini toolbar.

• Excel and 
PowerPoint have 
slightly different slightly different 
mini toolbars.
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New Formatting Tools - Galleries

• A gallery is a central location to access various preset
styles and appearance settings for an object.  There are 
various galleries for text styles, tables, shapes, and even 
charts.  The large availability of preset formats makes it 
easy to quickly alter any graphical object.

Predefined 
text styles 

arranged in a 
grid layout
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New Formatting Tools - Live Preview

• Live Preview allows you to preview how formatting 
options will look on a document before you actually 
apply the selected formatting.

Live preview of 
Comic Sans MS font
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Help

• Help can be found by clicking on the Question 
Mark icon on the right side of the Ribbon.

• Help includes offline and online support.
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The Options Dialog Box

• The program Options are now found under the Office 
Button.
– It used to be under the “Tools” menu in Office 2003.

Series Of Tabs
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Saving and Saving and 
File CompatibilityFile Compatibility

Office 2007

File CompatibilityFile Compatibility
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The New File Formats

• For documents, workbooks, and presentations, 
the default file format now has an “x” on the 
end, representing the XML format. For example, 
in Word, a document is now saved by default 

There are new file formats in Word, Excel, and 
PowerPoint:
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in Word, a document is now saved by default 
with the extension .docx, rather than .doc. 

• Excel = .xlsx

• PowerPoint = .pptx



Saving and File Compatibility

• By default, previous versions of Microsoft Office can not
open .docx. .xlsx, and .pptx files.

• For best compatibility , saving as the following is highly 
recommended:
– “Word 97-2003 Document (*.doc)” – “Word 97-2003 Document (*.doc)” 
– “Excel 97-2003 Workbook (*.xls)” 
– “PowerPoint 97-2003 Presentation (*.ppt)”

• To save you time and confusion, C&NS has set the 
default saving in Word, Excel, and PowerPoint to the 
“97-2003” file format so you don’t have to choose it every 
time.
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Saving and File Compatibility

• When you open an Excel, Word or PPT 97–2003 
formatted file in Office 2007, Compatibility 
Mode is turned on. 

• You see Compatibility Mode in brackets in the 
title bar of the document window. 
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• In Compatibility Mode, you can open, edit, and 
save Office 97–2003 files, but you won't be 
able to use any of the new Office 2007 
features.



Saving and File Compatibility

• To use the new Office 2007 features you can convert your 
files to the Office 2007 file formats.    (.docx, .xlsx, .pptx)

• Converting your files allows you to access the new and 
enhanced features in Office 2007.

Convert via the Office Button
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• However, people who are using previous versions of Office 
may be prevented from, or have difficulty, editing certain 
portions of the files that were created by using new or 
enhanced features in Office 2007.

(Example: SmartArt)
• To detect which 2007 features that will not be available in 

earlier versions of Office, you will use the Compatibility 
Checker.



Saving and File Compatibility

• The Compatibility Checker
– Used to detect features in Word, Excel and 

PowerPoint 2007 that will not function properly in 
earlier versions of those programs.

– Office Button>Prepare>Run Compatibility 
Checker.
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The Transition Period

• For computers with Office 2003, C&NS has 
installed the Compatibility Pack which allows 
users to open Word, Excel, and PowerPoint files 
created in Office 2007.

• Non-University computers need to have the 
latest Windows and Office updates to get the latest Windows and Office updates to get the 
Compatibility Pack.
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Notable Changes and New Features

• New default font style and size (change)
– Calibri, 11 pt

• New default spacing in Word(change)
Spacing 
option 

Word 
2007 

Word 2003 and earlier 
versions 
of Word 
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After 14 /10 px 0 pt 

Line spacing Multiple Single

At 1.15 blank

2003: 1.0 line spacing and no space between 
paragraphs.

2007: 1.15 line spacing and a blank line between 
paragraphs. (12pts = one blank line)



Changing the Default Font SettingsChanging the Default Font SettingsChanging the Default Font SettingsChanging the Default Font Settings

• You can change the default font settings in 
Word, Excel, PowerPoint, and Outlook 
2007.
– You can go back to the Office 2003 settings!

• To do so, you must go into each program • To do so, you must go into each program 
and change that program’s default 
settings.

• Instructions on how to do that can be 
found in the supplemental handout.
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Notable Changes and New Features

• Keyboard Shortcuts (change)
– The “older” keyboard shortcuts are no longer 

promoted.  But they still work! (Ctrl+C, Crtl+P, 
etc.)

– Press the “ALT” or “F10” to display the “Key 
Tips” for the Ribbon Tabs, Quick Access Tips” for the Ribbon Tabs, Quick Access 
Toolbar Commands, and the Office Button.  

• The little white squares containing the 
“Key Tips” are called badges .  Press the 
badge letter  or number associated with the 
command you want to use.
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Notable Changes and New Features

• Creating a New Document (change)
– Office Button
– Available Online Templates for a new document

• Save as PDF (New Feature)
– You do not need Adobe Acrobat Pro to create PDF’s!

• Enhanced Security Options (New Features)• Enhanced Security Options (New Features)
– Inspect Document
– Encrypt Document
– Digital Signature
– Mark as Final

• New Graphics and Formatting Capabilities (New Featu res)
– Smart Art, Quick Tables, Styles, Themes
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Office 2007 Review

Review Review 
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Review Review 
QUIZ!QUIZ!



Resources

• Web
– C&NS Office 2007/2008 Resource website:

• http://www.fairfield.edu/cns/cns_office2007

– Microsoft Office Training Website:
• http://office.microsoft.com/training

– The “Get Started” tab in the Ribbon for 
Word, Excel, and PowerPoint

• Print
– Quick Source Guides
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Rollout Plan

• http://www.fairfield.edu/cns/cns_office2007

• Spring ‘09
– Faculty and Faculty Support Staff

• Summer ‘09
– General University Staff

• Training
– General Staff and Faculty Training
– Class Types:

• Office 2007 Boot Camp (2 hr sessions)
• Speed Learning Office 2007 (2.5 hr session)
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Questions

Questions?

Thank You!
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